
 

5/6/16 Missouri Department of Transportation  

Chapter 6 

Corridor Modeling 

Overview 
6.1 Objectives .............................................................................................................................. 6-1 

6.2 Corridor Modeling Overview ................................................................................................ 6-1 
6.3 Prerequisites ........................................................................................................................... 6-2 

6.4 Corridor Modeling Tools ....................................................................................................... 6-2 
6.4.1 Corridor Creation Tasks ............................................................................................. 6-2 
6.4.2 Corridor Modification Tasks ...................................................................................... 6-6 

6.4.3 Superelevation Tasks .................................................................................................. 6-9 
6.4.4 Corridor Cross-Sections Tasks ................................................................................. 6-10 

6.4.5 Corridor Miscellaneous Tasks ................................................................................. 6-11 
6.5 Group Exercise: Creating a Corridor and Proposed Model ................................................. 6-26 
6.6 Individual Exercise: Creating a Corridor for Route63 ......................................................... 6-36 





GEOPAK Road 1 Chapter 6 – Corridor Modeling Overview 
 
 

5/6/16 Missouri Department of Transportation 6-1 

6.1 Objectives 

 Create Corridor 

 Assign Multiple templates to one corridor 

 Create new templates from  existing templates  

6.2 Corridor Modeling Overview 

The Corridor Modeling toolset is a group of highly interactive commands to create new design 

surfaces that represent a new roadway or other type of surface. Tools for creation, modification, 

management, and report functions are supported. 

Corridor Modeling tools aggregate a variety of civil data. The geometry is created with the 

Horizontal and Vertical Geometry tools, while the existing ground is defined by a MicroStation 

mesh or Civil Terrain Model. Plan view elements, such as edges of pavement, shoulders, curbs, 

etc. can be 2D or 3D. Superelevation information is defined within a design file using standards 

or imported data. Templates are utilized from one or more template libraries. 

Reference files can be used extensively with Corridor Modeling. On a simple project, the data 

may be all in one file; larger projects may have geometry in one file, plan view graphics in a 

second, terrain in another, superelevation in a fourth and the actual model in a fifth. All files can 

reference the others, to present a complete picture of the project. 

When working with Corridor Modeling, you can draw in 2D or 3D. When using 2D (such as for 

plan-view graphics), a 3D view is automatically created and maintained. For example, when a 

vertical geometry element is initially defined for a horizontal geometry element, the Default-3D 

model is created, if there isn’t one already. The 3D baseline (combination of horizontal and 

vertical element) is drawn into the 3D model. As template drops are added, and progressed, they 

are added to the 3D model automatically. 

When starting to create a corridor, basic information can be used. A single template can be used, 

along with preliminary geometry and a high level terrain model. As the design progresses, more 

detail can be added.  Instead of a single template drop, perhaps more templates better define the 

roadway. Transitions can be added to smoothly move from one template to another. There may 

be multiple roadways all interconnected using the target aliasing tools. All the while, as changes 

are made, the corridor model is updating, so you see up-to-the minute results. Simple projects 

may not require all the tools, and a basic corridor model may be sufficient. But all the tools are 

available to handle basic to complex, small-scale to large-scale projects. 
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6.3 Prerequisites 

The following are minimum requirements to use Corridor Modeling. 

 One Civil horizontal element and one Civil vertical element, generally the centerline and 

profile of the design roadway 

 One template stored in a template library 

A terrain model is not required for corridor modeling. If the template includes end conditions 

and no terrain model is defined, the software generates as much of the model as possible, but 

will not complete the end condition that ties to ground and no error message is given. 

6.4 Corridor Modeling Tools 

 

6.4.1 Corridor Creation Tasks 

The first toolbox is used when beginning design on a corridor and includes tools for creating 

corridors, template drops, and transitions; along with various tools for working with the 

template library. 

 

 Create Corridor - The Create Corridor tool is the initial step in corridor design; names the 

corridor and identifies the geometry.  No processing of templates is done within this tool; rather 

it’s a set-up step prior to template work. 

A closed shape is drawn to represent the corridor (using the full length of the civil geometry 

element). Station ranges to better define the corridor are utilized in the next step, template drops. 

When hovering over a corridor, two pop-up displays are visible: 
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 Quick Properties - displays the corridor name, horizontal geometry element (Plan), 

vertical geometry element (Profile), and Level of the corridor 

 Context sensitive menu with tools applicable to corridors 

After the corridor is created/drawn, the software automatically advances to the Create Template 

Drop tool. 

 Create Template Drop - defines what the cross sections of the roadway look like for that 

portion of the road based on user-defined station range. A project may comprise of a single 

template drop or multiple template drops. Often, transitions are used between two template drops, 

rather than an abrupt change from one template to another. 

Careful consideration should be given for the Drop Interval used for a corridor, although it can be 

changed at any time. It specifies the distance between each processing of the template (in master 

units). Generally, this value is equal to or less than (but still a multiple) of the desired interval for 

the final cross sections, since cross section stations should be coincident with processing stations. 

It is not necessary to set the interval so small that it encompasses all desired cross section stations, 

as stations with particular project interest can be added to the model with the use of the Key 

Station tool. If the model is to be used in construction, the smaller the interval, the more detailed 

the model, but will require more processing time. 

Note Drop Intervals are impacted by the Design Stages. 

 Minimum Transition Before Drop and Minimum Transition After Drop are inputs in the 

Create Template Drop tool. If they are non-zero, then a transition drop is created at the 

beginning/end of the template drop with a length greater than or equal to the value 

entered. The actual length is determined by how far it is between the new drop and the 

drop before/after the new drop. If there isn’t enough space to meet the minimum, then the 

previous/next drop is shortened to accommodate the transition. If there is no 

previous/next drop, then no transition drop is created. 
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After completing the prompts, the corridor is automatically processed and can be viewed in both 

2D and 3D views. The corridor can be rendered, if desired. 

 

The symbology is based on the feature definitions within the template. The Project Explorer is 

also updated with the corridor information, including template drops, components and features. 

Create Template Drop Workflow 

Select the Create Template Drop tool. This tool is automatically invoked at the end of the Create 

Corridor tool, but you can use it independently of the Create Corridor tool. 

Select the Corridor wherein the template drop will be added. 

1. Select Template - Select the template from the pull-down list of recently used templates, 

or select <Alt> <Down> on the keyboard to open the active template library and select 

the template. Data point to accept the template and move to the next prompt. 

2. Start Station - Graphically define the start station or enter the value in the edit field.  

Data point to accept and move to the next prompt. The Start station can be locked by 

<Enter> after keying in the station or selecting <Alt>.  Selecting <Alt> again unlocks 

the field. 

3. End Station - Graphically define the end station or enter the value in the edit field. Data 

point to accept and move to the next prompt. The End station can be locked by <Enter> 

after keying in the station or selecting <Alt>. The template is copied to the new station 

range. Selecting <Alt> again unlocks the field.  

4. Drop Interval - specifies the distance between each processing of the template (in master 

units). Generally, this value is equal to or less than (but still a multiple) of the desired 
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interval for the final cross sections, since cross section stations should be coincident with 

processing stations. Note that this is impacted by the Design Stages. 

 

 

 Create Transition - A transition is created between templates of different names, as 

templates generally don’t instantaneously change from one template to another. This tool creates 

the transition by selecting the two templates drops which are adjacent to it. It does not define how 

to transition between the template drops, which is done in the Edit Transition tool. 

If the drop interval is not the same in the two template drops, the drop interval of the lower 

stationed template drop is utilized. However, this can be changed in the Transition Properties. 

Create Transition Workflow 

1. Select the Create Transition tool. 

2. Select the first template drop adjacent to the transition. It does not matter the order in 

which the two template drops are selected. 

3. Select the second template drop adjacent to the transition. The transition is created (and 

the corridor has automatically processed).  

 

 

 

 

 Edit Transition - Modifies the previously created transition between two template drops. 

Edit Transition Workflow 

Editing a transition is a two-step process. 

1. Connect the backbone points of the first template to the backbone points of the second 

template, as desired. Unconnected points are shown as thick (+) symbols; connected 

points are thin (+) symbols. End conditions are not shown. End condition transitions are 

handled through end condition exceptions. 

2. Edit the transition components. 

The color of the transition indicates the state of the transition. 

 Red - indicates that none of the backbone points of the first template connect to the 

backbone points of the second template. 

 Yellow - indicates that some of the backbone points are connected (initially this is done 

attaching points that have the same name. 

 Light Blue - indicates that not all of the points are connected, but you have reviewed 

and/or edited the transition at least once. 
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 Dark Blue - indicates that all of the points on both templates are connected. 

 Copy Template Drop - As an alternate to creating and modifying a template drop, this tool 

copies an existing template drop to a newly defined station range along the same baseline 

reference. 

The Copy Template Drop tool can be used as an alternate to creating and modifying a template 

drop, as the tool copies an existing template drop to a newly defined station range along the same 

baseline reference within the same corridor. 

Copy Template Workflow 

1. Select the Copy Template Drop tool. 

2. Locate Template Drop - Select the previously created template that you want to copy to 

a different location. 

3. Start Station - Graphically define the start station or enter the value in the edit field. 

Data point to accept and move to the next prompt. The Start station can be locked by 

<Enter> after keying in the station or selecting <Alt>. Selecting <Alt> again unlocks the 

field. 

4. End Station - Graphically define the end station or enter the value in the edit field. Data 

point to accept and move to the next prompt. The End station can be locked by <Enter> 

after keying in the station or selecting <Alt>. The template is copied to the new station 

range. Selecting <Alt> again unlocks the field. 

 Create Template - Opens the current template library to add a new template, delete or 

modify an existing template.   

 Display Template - Draws the selected template from the current template library at the 

user-defined data point in the drawing file using the active MicroStation symbology. All end 

conditions are drawn and there is no annotation. The drawing is useful as a starting point for 

documentation of the template library. 

6.4.2  Corridor Modification Tasks 

This toolbox contains tools for manipulation of a previously created corridor and associated 

template drops. These tools enable you to refine the model by adding more detailed information to 

respond to project-specific requirements and constraints. 

 

 Edit Template Drop - Opens the current template library and displays the template with the 

selected template drop.  While the dialog is the template library interface, keep in mind that the 

editing is only being done to the template within the template drop, not the actual template library. 

Therefore, if any changes are made, the template associated with the template drop is no longer in 
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sync with the template library. For project specific circumstances, this may be required. The tools 

and options within the edit template drop function identically to those in the template library, 

except the File tools are not available. 

If the changes are needed in the template library, use the Create Template tool. 

To update the template associated with the template drop to match the template in the template 

library, use the Synchronize with Library tool. When this tool is used, the template from the 

template library overwrites the template associated with the template drop, so all changes are lost 

with no warning given. 

Edit Template Drop Workflow 

1. Select the Edit Template Drop tool. 

2. Locate the Template Drop. Select the template drop whose template needs editing. The 

Editing Roadway Design Template Drop dialog (whose interface is identical to the 

Template Library dialog) opens with the current template. 

3. Edit as needed. Click OK to close the dialog. You do not have to File > Save to save your 

edits (most File functions are ghosted out). 

 Create Point Control These are used to override the normal locations of one or more points 

and or components in a cross section.  Examples of this include lane widening, staying within the 

right-of-way, maintaining a particular slope for a ditch, and superelevation. 

An example would be a ramp is merging into the main road. The ramps left edge is vertically 

controlled by the main road right edge of pavement. The ramps left edge is horizontally controlled 

by the main road right edge from 0+00 to 1+00, and then it is controlled by a horizontal alignment 

named rampLeft. 

Station Limits (Start/Stop) - specifies the start and stop stations for the control. 

Control Description - allows you to enter a description of the control. 

Point - allows you to select the point to be controlled. Select from the list or identify the point 

in the cross-section using the locate button. The selected point is highlighted in plan/cross 

section and profile or superelevation views as applicable. 

Mode - allows you to select the control mode: Horizontal, Vertical, or Both. 

Control Type - specifies the type of control. 

If the Mode is Horizontal or Both, valid control types are Linear Geometry, Feature 

Definition, or Corridor Feature. 

If the Mode is Vertical, valid control types are Linear Geometry, Feature Definition, 

Corridor Feature, Superelevation, Elevation Difference, Elevation and Grade. 

The selection combo boxes and/or field displayed depends on the selected Mode and 

Control Type. 
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Type - Linear Geometry If the type is Linear Geometry, a Horizontal Offsets combo box 

is displayed. If the mode is Both, a Vertical Offsets combo box is also displayed. 

Type - Feature Definition If the type is Feature Definition, a Feature Definition and 

Range text field is displayed. 

Type - Corridor Point For all modes, Corridor and Reference Feature combo boxes are 

displayed. These options allow you to set up the control of one corridor’s points(s) from 

another corridor’s point(s). 

Targeting another corridor's point cannot be done simultaneously with Target Aliasing of 

that same corridor. If Target Aliasing has been defined, the Corridor Point is not available 

for selection within the Point Control dialog. This produces a recursive situation, making 

the corridor point control unavailable for selection until that Target Aliasing is removed. 

Type – Superelevation This option displays a Superelevation control line combo box, and 

a Reference Point combo box. Superelevation control lines are stored in the roadway 

design, not on the alignment. The reference point is the pivot point (feature) about which 

the point will rotate. 

Type - Elevation Difference This option displays Horizontal and Vertical alignment 

combo boxes. The vertical alignment represents a vertical difference value to be applied to 

the points’ current elevation. 

Type - Elevation and Grade This option displays an Elevation field, and a Grade field. 

The control sets elevation of the point at the start station to the elevation specified. The 

slope of the point’s line is then at the grade specified until the end station is reached. 

Priority - determines the order of controls on a point. This value applies only when there are 

conflicting controls on a point. Where there is a conflict, the control with the lower priority is 

applied (that is, lower numbers are applied first). 

Use as Secondary Alignment - specifies that horizontal point controls are also used as 

secondary alignments. This option is available only when working with a 2D entity. If you are 

using a 3D object, the software skips the secondary alignment option. 

Horizontal Offsets (Start/Stop) - specifies the start and stop horizontal offset controls for the 

corridor. If the values are different, then the value applied at a given station is calculated using 

a linear algorithm. 

Vertical Offsets (Start/Stop) - specifies the start and stop vertical offset controls for the 

corridor. 

 Create Key Station - The Create Key Station tool is useful to add stations that are not 

coincident with the template interval, when a special circumstance of the project occurs and it’s 

desirable to include the station in processing. 

Create Key Station Workflow 

1. Select the Create Key Station tool. 
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2. Locate Corridor - Select the corridor for station addition. A display line dynamically 

running perpendicular to the baseline reference is visible. 

3. Station - Define the key station by dynamically moving the display to the desired 

location (and data point) or by keying in the station, <Enter> and data point to accept. 

The key station is added to the Key Station list, and the corridor is automatically 

reprocessed to include the new station. 

 Create Secondary Alignment - Sets parameters for secondary alignments, which are used 

to modify the direction of cross section processing. Requirements include corridor selection, 

secondary alignment definition, beginning and ending station (in cases where only part of the 

alignment element is to be used) and beginning and ending offsets. 

 Create Parametric Constraints - Sets up constraint value overrides for specified station 

ranges. 

 Create Curve Widening - Applies horizontal controls to points to move them farther from 

the centerline at each curve of the controlling alignment. 

 Create End Condition Exception - Defines end condition exceptions, which are used to 

modify the behavior of an end condition solution without requiring the use of additional template 

drops. 

 Corridor Objects - One-stop viewing of data relating to corridor objects. Excellent for 

managing your corridor data, as it encompasses template drops, key stations, parametric 

constraints, point controls, various references and end condition exceptions all within one dialog. 

 Process Corridor - Processes the corridor to ensure that it is up to date. 

6.4.3 Superelevation Tasks 

This toolbox contains tools for creating, calculating, and editing superelevation lanes. Tools are 

also supported for importing excel (CSV) data and reporting. 

 

 Create Superelevation Sections - Adds a superelevation sections (generally one per curve 

set) for the specified station range on the baseline reference. 

 Create Superelevation Lanes - Creates color-filled lanes based on width and offsets from 

the baseline reference, as a precursor to superelevation calculations. 
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 Calculate Superelevation - Calculates station and superelevation transitions rates based on 

a preferences or rules file (*.sep,*.srl).  The values are augmented to the superelevation lanes, 

edit manipulators are created, and the color fill is recolored based on the cross slopes. 

 Import Superelevation - Optionally, imports data from a CSV file. 

 Assign Superelevation to Corridor - Associates superelevation with a corridor, so the 

pavement reflects the superelevation stations / cross slopes, rather than the pavement cross slope 

defaults in the template. 

 Insert Superelevation Station/Cross slope - Insert an individual station / superelevation 

transition (cross-slope) into a previously created and calculated superelevation lane. 

 Superelevation Editor - Opens the superelevation editor allowing the user to edit the 

calculated superelevation in a tabular format. 

 Superelevation Report - Creates a superelevation XML report and opens the Bentley Civil 

Report Browser. 

 Superelevation in Plan - Automatically generates annotation for superelevation station 

information in plan view. 

6.4.4 Corridor Cross-Sections Tasks 

This toolbox contains tools to display, draw, and annotate cross sections. 

 

 Open CrossSection View - Using the specified baseline reference to a corridor, or any Civil 

horizontal geometry, creates a dynamic cross section view in the user-selected MicroStation view. 

The corridor interval is used for the cross section interval. The specialized view has exaggeration 

feature, cross section scrolling, and ability to place temporary dimension lines. These sections are 

not used as a basis for drawn cross sections or sheets. 

 Create Cross Sections - Extracts multiple cross sections and draws them in a matrix pattern. 

These sections are subsequently used for cross section sheets and earthwork calculations.  The 

display configuration and layout is controlled by an .xin file.  This is covered in detail in 

Chapter_09 Cross Sections and Labeling. 

 Annotate Cross Sections - Placed with the Create Cross Sections tool. 
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 End Area Volume - Calculates the end-area volumes to compute cut, fill, and net volumes 

using a series of cross sections extracted along a previously defined alignment. 

 Edit Station - Allows the user to edit the cross section instance at a station. 

 Show Place Dimension - Places display text (width, slope) into the dynamic cross section 

view, based on two data points. Multiple show place dimension elements can be placed in a single 

cross section view. 

 Remove Temporary Dimension - Removes dimensions in the dynamic cross section view 

that were placed with the Show Place Dimension tool. 

 Locate Station Via Datapoint - Places a data point (in plan view) with this tool to view a 

dynamic cross section at a station not included on the list. 

 Cross Section Viewer - Windows in on specified cross sections in a model. Using Cross 

Section Viewer, you can view a single cross section, or you can view in succession each cross 

section in a model. 

6.4.5 Corridor Miscellaneous Tasks 

 

 Define Target Aliasing - Aliasing allows you to target other corridor surfaces or features or 

to set up a prioritized target list for end condition solutions on surfaces, features and alignments. 

This means that on a large job where the existing surface may have been broken up into more than 

one surface, you don’t need to be concerned about where those breaks occur, and you don’t need 

to create a different template for each existing surface. Use target aliasing to find the proper 

solution. 

In any situation where the active surface is the target, the software looks for the mainline corridor 

surface and uses whichever is closer because you have turned on that option. If the Use Closest 

option is not set, then it would search for the surfaces in the order they are displayed, and it would 

stop as soon as a solution was found. 

Target Aliasing cannot be defined with a corridor that targets that particular corridor with a 

Corridor Point Control. This produces a recursive situation, making the corridor unavailable for 

Target Aliasing until that corridor point control is removed. 

Target lists end-condition targets for the current corridor. 

does not list feature definition targets. 
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Surface or Corridor lists all the available aliases for the current target. If the target is a 

surface, it displays a list of alternate surfaces and corridors. If the target 

is a feature, then the list displays available surface features and corridor 

points. If the target is an alignment, it displays a list of available 

alignments. 

Aliases lists the aliases for the current target. The order of the list indicates the 

priority of the target aliases. 

Add, Remove, Move 

Up, Move Down 

activates as items are selected. The left and right buttons allow you to 

move items between lists. More than one item can be selected and 

moved. The up and down buttons allow you to change the priority of a 

single item in the alias list by moving up or down in the list. 

Use Closest Ignores the order of the aliases, when checked on. The solution seeks 

the closest alias that satisfies the solution (end condition). 

Define Target Aliasing Target Workflow 

1. Select the Define Target Aliasing tool. 

2. Select the corridor. This opens the Target Aliasing dialog. 

3. Use the Add, Remove, Move Up, Move Down, and Use Closest to set the Target Aliasing. 

 Synchronize Template - Updates a template within a template drop with the template of the 

same name from the current template library. Any changes previously made to the template in the 

template drop are overwritten with no warning. 

 Add Corridor Reference - The Add Corridor Reference tool adds graphical elements to the 

corridor processing. This must be done even if the feature is targeted in the template, otherwise 

the elements will not process. It enables only those elements associated with a particular corridor 

to be processed, rather than all elements of a particular feature definition. This speeds up 

processing, and eliminates processing of unwanted elements of the same feature definition. The 

elements can be selected within the tool, or a selection set can be created prior to commencing the 

tool. 

Add Corridor Reference Workflow 

1. Select the Add Corridor Reference tool. 

2. Select the Corridor. 

3. Select the First Reference Element - select the graphical element to be added as a 

reference. Continue selecting until all elements are referenced, then reset to exit tool. 
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 Remove Corridor Reference - The Remove Corridor Reference tool removes graphical 

elements from the corridor processing, but does not delete the element. The elements can be 

selected within the tool, or a selection set can be created prior to commencing the tool. 

Remove Corridor Reference Workflow 

1. Select the Remove Corridor Reference tool. 

2. Select the Corridor. 

3. Select the First Reference Element - select the graphical element to be removed as a 

reference. Continue selecting until all elements are referenced, then reset to exit tool. 

 Add Clipping Reference - allows you to remove areas of overlap when working with 

multiple corridors in a single surface. For example, in a corridor intersected by a crossing 

roadway, clipping would be used to remove all overlapped features within the intersection. 

Add Clipping Reference Workflow 

1. Select the Add Clipping Reference tool. 

2. Select the corridor to be clipped. 

3. Locate Clipping Reference - select elements until all are defined, then reset to complete. 

The corridor is processed and the clipping reference is added. 

 Remove Clipping Reference - Removes the clipping reference, reprocesses the corridor, 

restoring the clipping area to its previous state prior to clipping. 

Remove Clipping Reference Workflow 

1. Select the Add Clipping Reference tool. 

2. Select the Corridor where the clipping is to be removed. 

3. Locate Clipping Reference - select elements until all are defined, then reset to complete. 

The corridor is processed and the clipping reference is removed. 

 Overlay Vertical Adjustment - At each processed station, this command determines the 

ideal PGL point based on the input criteria and the distance from the top of the template to the 

existing ground. Each existing ground vertex in the cross section will be tested by measuring the 

vertical distance between that ground point and the top of the template. 

Geometry and corridor must be in the same DGN file for this command to operate. 

This command is not available when the geometry is in a reference file because the command 

creates a vertical alignment and the corridor must reprocess to determine criteria for the vertical 

alignment. 

 Import IRD - Imports (SELECTseries 2) and prior versions of corridors contained in 

Roadway Designer (IRD) files. 
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Import IRD Workflow 

Recommendations and limitations: 

1. Select the IRD file that contains the corridors to import. 

2. Select the corridor to import and data point to accept. 

3. If the selected corridor contains no missing dependencies, the corridor is imported. 

Otherwise, a Missing Corridor Dependencies report displays. 

4. If the Missing Corridor Dependencies report displays, select No to cancel the import or 

select Yes to continue the import process. Note: The report can be saved to a text file for 

later reference. 

5. If the import is canceled, resolve missing dependencies and then re-import the corridor. 
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Missing Dependencies 

If a corridor is selected to be imported and it contains corridor objects with missing dependencies, 

a missing dependencies report displays before the corridor is imported into the design file. The 

report dialog allows the import to be continued or canceled by selecting Yes or No. This allows 

missing dependencies to be resolved before a corridor is imported. 

A corridor may contain one or more corridor objects. Corridor objects include template drops, 

secondary alignments, key stations, parametric constraints, point controls, end condition 

exceptions and target aliases. Some of these object types depend on other entities in the design 

model. They include secondary alignments, point controls, and target aliases. If one of these 

objects depends on an entity that does not exist in the design model, its dependency is missing. 

Example, a secondary alignment object depends on a horizontal alignment. If a corridor is 

imported that contains a secondary alignment whose horizontal alignment is "Side Street 1", the 

horizontal geometry named "Side Street 1" must exist in the design model. If it does not, that 

secondary alignment is missing its dependency and cannot be imported. To resolve the missing 

dependency the alignment "Side Street 1" could be imported using the Import Geometry 

command or one of the horizontal geometry commands could be used to create "Side Street 1". 

Corridor object dependencies are always matched by name. They are not matched by GUID or 

object ids. Example: If a point control is a corridor feature point control, the corridor and the 

corridor feature must exist in the design model in order to import the point control. There must be 

a corridor in the design model whose name matches the corridor name stored in the point control, 

and that corridor must contain a feature whose name matches the feature name stored in the point 

control. 

Recommendations and Limitations 

 It is recommended that best practice rules for creating corridors be followed when 

importing corridors. 

 Only one corridor at a time can be imported using Import IRD. 

 In order to import a corridor, its baseline horizontal and profile geometry must exist in 

the design file or an attached reference file. 

 When a corridor is imported its end conditions will always target the active terrain model, 

but corridors may be imported without an active Terrain Model. In that case, end 

conditions will target nothing. 

 When importing corridors that contain secondary alignments, the ALG that contains the 

secondary alignment geometry must reside in the same directory as the IRD. This is 

because the secondary alignment geometry is a dependency that must exist in the design 

model and the dependency match is made by the name of the geometry. The ALG file 

must be accessed to look up the name of the geometry. 

 In order to import a Target Alias at least one of its dependencies must exist in the design 

model. Missing aliases will not be imported. Example, if a target aliases a terrain model 

and a corridor, but only the corridor exists in the design model. The target will be 

imported and the corridor alias will be imported, but not the terrain model alias. If neither 

the terrain model nor the corridor exists then neither the target nor any aliases will be 

imported. 
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Managing Corridor Data 

Several tools can be used to help manage the corridor model data. Depending on the tool 

selected, the data may be read-only or may be manipulated. These include: 

Element Info 

 Properties 

 Corridor Objects - view and manage all the input objects in the corridor in one location 

 Project Explorer - see all corridor information in one place 

 Design Stages 

Element Info 

Clicking on the corridor border opens the Element Information with most of the same 

information found in the Project Explorer Corridor. It includes the corridor tree, symbology, 

Corridor Info (Name, Alignment Name, Profile Name, and Design Stage). 

 

The dialog changes as the tree is navigated, based on the current highlighted item in the tree. 

Much of the information can be edited, which is automatically reflected in the corridor model. 
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If a Template Drop is selected, the Element Information dialog reflects the template drop 

information, which can be edited. 
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Properties - is similar to Element Information, as the displayed data reflects the type of element 

selected. For example, the data displayed when a corridor is selected is different than when a 

template drop is selected. 

The Properties tool is accessed via the context sensitive menus. When a corridor is selected, the 

display shows names and design stages. 

Corridor Objects - Allows you to view and manage all the input objects in the corridor in 

one location. 

Project Explorer 

The Project Explorer located in Tools>Project Navigation>Links>Project Explorer is another 

location where corridor model data is organized and displayed. As the design progresses, the 

information is continually created / updated automatically. The information is located under the 

Civil Model tab. 
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Each corridor (and associated data) is listed separately. As the tree is navigated, additional data is 

exposed. In addition, right-click context sensitive menus are available for common tasks and 

information. 
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Project Settings  

Project Settings can be located under the Civil Standards tab in the Project Explorer. 

Template Management 

 

The Template Drop Interval Multiplier can be accessed by opening the Element Information 

tool, and expanding Project Settings in the Project Explorer window, then expand the 

Corridor Design Stages and selecting the stage to show Template Management.  

 

The Template Drop Interval Multiplier is used in conjunction with the Interval Drop specified 

when the template drop was created. Its purpose is to enable designers to use larger intervals for 

preliminary work and easily shorten the interval as the design is refined. To determine the 

interval used for processing, the Interval Drop is multiplied by the Template Drop Interval 

Multiplier and the result is used.  

MoDOT uses the following multipliers: 

 

Stage Multiplier Resultant Processing 

Interval 

Description 

Preliminary 40 200 As corridor is determined, 

areas of impacts and issues 

can be reviewed. 

Design 20 100 Used for general design work, 

until high level of accuracy is 

required towards the end of 

the project. 

Final 5 25 Used for cross section sheets 

with 25 or 50 feet between 

sections. 
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Include Critical Sections 

This information is also located in the Element Information tool when the Corridor Design Stage 

is selected in the Project Settings of Project Explorer. 

 

Option Description 

Horizontal Cardinal Points When set to True, the location of cardinal points of the 

active horizontal alignment (PC, PT, CS, etc.) are used 
to compute a point or template drop interval location. 

Vertical Cardinal Points When set to True, the location of cardinal points 
of the active vertical alignment (VPC, VPT, VPI, etc.) 
are used to compute a point or template drop interval 

location. 

External Control Points When set to True, the location of horizontal and/or 
vertical point controls are used compute a point or 
template drop interval location. 

Densify Horizontal Curves When set to true, the processing along horizontal curves 
is at a closer interval. This option utilizes the 

CIVIL_DEFAULT_CURVE_STROKING configuration 
variable value, with extra points being computed based 
on the chord offset from the horizontal curve. The value 
defines the chord height used to calculate the extra 
points. If configuration variable is not set or Densify 

Horizontal Curves is set to False, the value defaults to 
0.01. 
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Display Settings 

This information is also located in the Element Information tool when the Corridor Design Stage 

is selected in the Project Settings of Project Explorer. 

 

Option Description 

Corridor - Element Template Element template utilized to draw the corridor 
boundary in the Create Corridor tool.  As a best 
practice, place the graphics for the boundaries in a 
construction class to allow for easily turning them off / 
on as needed. 

Corridor Handle Length Factor 

Template Drop Handle Length 

Factor Single Station Handle 

Length Factor 

Transition Handle Length Factor 

The Length Factors are a ratio of the handle length to 
the width of the corridor.  So 1.0 would make the 

handle as long as the width of the corridor at that point. 

Corridor Handle Spacing The handle spacing either is set to a physical distance as 
shown or set to zero. If you set to zero you will get 11 
handles per corridor regardless of its length.  Any non-
zero value is used as a distance between handles 

measured in master units along the horizontal 
alignment. 

Template Drop Element Template Element template utilized to draw the template drop 
boundary in the Create Template Drop tool.  As a best 
practice, place the graphics for the boundaries in a 
construction class to allow for easily turning them off / 

on as needed. 

Transition Element Template Element template utilized to draw the transition 
boundary in the Create Transition tool.  As a best 
practice, place the graphics for the boundaries in a 
construction class to allow for easily turning them off / 

on as needed. 
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Output Settings 

This information is also located in the Element Information tool when the Corridor Design Stage 

is selected in the Project Settings of Project Explorer. 

 

For all options, when set to False, no elements, features, or meshes are drawn. 

Option Description 

Create Top Mesh 

Top Mesh Feature Definition 

When set to True, a mesh is created for each component in the 
corridor (based on its template) which has Exclude From Top / 
Bottom Mesh toggled OFF.  The mesh is drawn using the specified 
Feature Definition. 

 

 

If Create Top Mesh is set to False, no Top Mesh Feature Definition 
can be selected. 

Create Bottom Mesh 

Bottom Mesh Feature Definition 

When set to True, a mesh is created for each component in the 

corridor (based on its template) which has Exclude From Top / 
Bottom Mesh toggled OFF.  The mesh is drawn using the specified 
Feature Definition.  If Create Bottom Mesh is set to False, no Bottom 
Mesh Feature Definition can be selected. 
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Create Linear Features 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When set to True, 3D linear features are drawn based on Feature 
Definitions.  First, review the Point Properties within the template: 

 

 

Then review the corresponding Feature Definition. 

 

 

If the Create Template Geometry setting is set to True, then the linear 
feature is drawn, based on the 3D settings. 

 

 
 

 

 

Then review the corresponding Feature Definition. 

 

 

If the Create Template Geometry setting is set to True, then the linear 
feature is drawn, based on the 3D settings. 
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Create Linear Features Continued  

 

If the Create Template Geometry setting is set to True, then the linear 
feature is drawn, based on the 3D settings. 

 

 

Create Component Meshes When set to True, a mesh is created for each component in the 
corridor (based on its template) which has Exclude From Top / 
Bottom Mesh toggled On.  The mesh is drawn using the specified 
Feature Definition in the Component Properties. 

 

 

Include Null Point Linear Features When set to True, linear features for null points are drawn, basis on the 
same criteria as Create Linear Features. 
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6.5 Group Exercise: Creating a Corridor – Road1 

Setting up the Design files 

1. Within the J2P0200\data_06 folder, open the file: Plan_J2P0200.dgn 

2. Create a new file named Corridors_J2P0200.dgn based on the 2D seed file 

pw:\CADD_Standards\Seed Files\Design - English\i_project_2d_PowerGEOPAK.dgn.  

This new file will hold the proposed corridor.   

3. Reference in the following files: 

Terrain_J2P0200_Existing.dgn 

Civil_Geometry_J2P0200.dgn. 

 

4. Data point on the perimeter of the Terrain Model and select the Set As Active Terrain 

Model icon form the pop up menu. 

 

Setting up the project template Library 

5. From Corridor Modeling task group of the Civil Tools task menu, select Create 

Template.    Or press the <F8> key to open the Create Template dialog. 

6. Select file open and navigate to the the project diretory and open the project template 

library: J2P0200.itl. 

7. Expand the Concrete Pavement w/ Shoulders folder in the Templates folder. 

8. Within this folder expand the A2 Shoulders Agg Base folder. 

9. Right click on the Concrete Pavement 2 Lane w/ Agg Base Option 3 template and 

select Copy. 

10. Expand the J2P0200 folder and right click on the Road1 folder then select Paste. 

11. Expand the Concrete Pavement w/ C&G folder. 

12. Right click on 2 Lanes Type A C&G w/ Agg Base and select Copy. 

13. Expand the J2P0200 folder and right click on the Road1 folder and select Paste. 

14. Once the 2 Lanes Type A C&G w/ Agg Base is pasted in the Road1 folder we are going 

to modify the 2 gutter flowline points named RT_Curb_Surf_Flowline & 

LT_Curb_Surf_Flowline.  The project parameters call for the gutters not to super 

elevate with the roadway. 
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15. Below is the original Point Constraint for RT_Curb_Surf_Flowline. 

 

16. Change to a Slope Constraint to -7.41% and add a Parametric Label of 

RT_Gutter_Slope. 

   

17. Select apply to update the template. 

18. Edit the same flow line point on the left side. 
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19. Review the new Road1 templates by double clicking the name in the list.  Turn the 

Display Point names On/Off.  Select Test to verify the end condition functionality. 

 

2 Lanes Type A C&G w/ Agg Base 

 

Concrete Pavement 2 Lane w/ Agg Base Option 3 

 

 

20. Select File> Save to save the changes to the project J2P0200.itl. 

21. Close the Create Template dialog. 

Setting up the Corridor 
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22. From Corridor Modeling task group, select Create Corridor.  

Create Corridor command is also available from the context sensitive pop-up menu 

presented when hovering over a selected horizontal civil geometry element.  

 

 

23. When prompted to Locate Corridor Baseline, data point on Road1. 

 

24. Right-click to reset to select the active profile. 

 

25. Name the Corridor Road1. 

 

26. Data point to accept. 

27. Select <Alt> + Down to pick a template or use the Create Template Drop dialog box. 

28. Expand the project folder J2P0200 and Road1 folders.  Select the 2 Lanes Type A C&G 

w/ Agg Base template.  Click OK to dismiss the dialog and data point in the view to 

accept the choice of template. 

29. When prompted to enter the Start Station, select the <Alt> key to lock the Start Station to 

the start and data point in the view to accept it. 
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30. When prompted to enter the End Station, key in 25+30 and Tab to lock the value. Data 

point in the view to accept the end station. 

 

31. When prompted for the Interval, key in 5 and Tab to lock the value and data point to 

accept the value. 

32. Key in 0 (if it doesn’t default to 0) for the Minimum Transition Before Drop   and 

Minimum Transition After Drop, data point after each  until the corridor processes. This 

applies the template to the Road1 corridor for the stationing identified. 

33. Select <Alt> + Down to pick another template or use the Create Template Drop dialog 

box. 

34. Expand the folder J2P0200 and the Road 1 folder and select Concrete Pavement 2 Lane 

w/ Agg Base Option 3 template. Click OK to dismiss the dialog and data point in the 

view to accept the choice of template. 

35. When prompted to enter the Start Station, key in 25+30 and Tab to lock the value.  Data 

point in the view to accept the start station. 

 

36. When prompted to enter the End Station, select the <Alt> key to lock the End Station to 

the end and data point in the view to accept it. 

 

37. When prompted for the Interval, key in 5 and Tab to lock the value and data point to 

accept the value. 

38.  Key in 0 (if it doesn’t default to 0) for the Minimum Transition Before Drop   and 

Minimum Transition After Drop, data point after each  until the corridor processes. This 

completes the template drop for Road1 by applying the template to the stationing 

identified.  The corridor will process and display in both the 2D view and the 3D 

Isometric view. 

39. Select <F4> to close the Create Template Drop tool down. 

40. Press <F6> key to setup the 3D view. 

Hint: If you don’t see end conditions then the original ground terrain model was not 

active. 
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Review the model and the effect of Design stages 

41. Select the corridor by picking one of the handles. 

42. Select the Corridor Component Quantities option from the Corridor Reports pop-up. 

 

43. Key in some unit cost values. 

44. Select Report. 

45. Review the reports available.  Close the Report Browser. 

46. Display the pop-up menu again and select Properties. 

 

47. Select and explore the options for Design Stage. 
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48. Use the View Rotation tool to rotate the view to see 3D effects on the Road1 corridor. 

 

 

 

 

 

Set up Dynamic Cross sections 

49. From Corridor Modeling task group, select Open Cross Section View.  

Open Cross Section View command is also available from the context sensitive pop-up 

menu presented when hovering over a corridor handle.  
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50. When prompted to Locate Corridor or Alignment, identify the corridor by selecting a 

grab handle on the corridor. 

 

 

51. When prompted to Select or open View, select a view not in use and data point in the 

view.  This will present the first Cross Section of the corridor.  To Navigate up and down 

the corridor use the arrow indicators at the top of the view.  To navigate within in the 

view, use the mouse wheel; rolling the wheel forward zooms in, rolling back zooms out.  

Depressing the wheel and moving the mouse pans the view. 

 

Since superelevation will be changing the slopes, having feedback to the slope at each station is 

useful, the next steps describe how to place a dimension line from the edge of pavement to the 

center line on each side of the road. 

52. Select Show Place Dimension.  Located in the Corridor Modeling tools in the Civil 

Tools tasks. 

53. Select the Cross Section view. 

54. At the Start Point prompt, identify the left EOP named LT_Conc_T_EOP, data point to 

accept. 
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55. At the End Point prompt, identify the centerline point named Conc_T_CL, data point to 

accept. 

 

56. Place the dimension height above or below the component in a location that will be easy 

to read, data point to accept the location.   

 

Note:  This places the same dimension on all cross sections. 

Note:  The blue line on the alignment represents the location of the cross-section. 

 

57. Close View 7. 



GEOPAK Road 1 Chapter 6 – Corridor Modeling Overview 
 
 

5/6/16 Missouri Department of Transportation 6-35 

58. Save Settings on the design file.  The corridor is stored as MicroStation data; no .ird file 

is created. 

Important!  If you delete the graphics, you delete the corridor and both the 2D and the 

3D display. 

Note:  The User might notice there is no superelevation applied to the corridor, this is 

covered in the next chapter.  

59. Select File > Update Server Copy.  
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6.6 Individual Exercise: Creating a Corridor for Route63 

1. Continue working in Corridors_J2P0200.dgn.   

2. From Civil Tools task menu under Corridor Modeling, select Create Template.  

3. Select File > Open and navigate to the location of the project template file J2P0200.itl 

and open the file. 

4. In Create Template dialog right-click on the J2P0200 folder, select New > Folder and 

create a folder called Route63. 

 

5. Expand the Templates > Concrete Pavement w/ Shoulders folder. 

6. Expand the A3 Shoulders Agg Base folder. 

7. Right click on the Concrete Pavement 4 Lane Divided w/ Agg Base Option 3 template 

and select Copy. 
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8. Right click on the Route63 folder and select Paste. 

9. Test the template by clicking Test. 

10. Save your changes to the J2P0200.itl and then close the Create Template dialog. 

11. From Corridor Modeling task group, select Create Corridor  

12. When prompted to Locate Corridor Baseline, data point on Route63. 

13. Right-click to reset to select the Active Profile. 

 

14. Name the corridor Route63. 

 

15. Data point to accept. 

16. Select <Alt> + Down to pick a template or use the Create Template Drop dialog box. 

17. Expand the folder J2P0200 and the Route63 folder. 

18. Select the Concrete Pavement 4 Lane w/ Agg Base Option 3 template.  Click OK to 

dismiss the dialog and data point in the view to accept the choice of template 

19. When prompted to enter the Start Station, key in 10+00 R1, Tab to lock the station, and 

Data point in the view to accept. 

 

20. When prompted to enter the End Station, select the <Alt> key to lock the End Station to 

the end and data point in the view to accept it. 

 

21. When prompted for the Interval, key in 5 and Tab to lock the value. 

22. Key in 0 (if it doesn’t default to 0) for the Minimum Transition Before Drop   and 

Minimum Transition After Drop, data point after each  until the corridor processes. The 

corridor will process and display in both the 2D view and the 3D Isometric view.  This 

applies the template to the Route63 corridor. 
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23. Select <F4> to close the Create Template Drop tool down. 

24. From the Properties pop-up menu, select and explore different design stages. 

25. If the 3D View is not open select <F6> key to open a 3D view of the corridors. 

26. Using the View Rotation tool, rotate the view to see 3D effects of J2P0200 Route 63 

corridor.  

 

 

Set up Dynamic Cross sections 

27. Select Open Cross Section View  from the Corridor Modeling task group, to review 

the dynamic cross sections. 

28. When prompted to Locate Corridor or Alignment, identify the Route63 corridor by 

selecting a grab handle on the corridor. 

 

29. When prompted to Select or Open View, select a view not in use, (View 8) and data 

point in the view.  This will present the first Cross Section of the corridor.  To navigate 

up and down the corridor, use the arrow indicators at the top of the view.  To navigate 

within in the view, use the mouse wheel; rolling the wheel forward zooms in, rolling back 

zooms out.  Depressing the wheel pans the view. 

Since superelevation will be changing the slopes, having feedback to the slope at each station is 

useful, the next steps describe how to place a dimension line from the edge of pavement to the 

center line on each side of the road. 

30. Select Show Place Dimension  from the Corridor Modeling task group. 
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31. Select the Cross Section view. 

 

32. At the Start Point prompt, identify the left EOP named LT_Conc_T_EOP.  

 

 

33. At the End Point prompt, identify the right EOP named RT_Conc_T_EOP. 

 

 

34. Place the dimension height above or below the component in a location that will be easy 

to read, data point to accept the location.   
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35. Do this for both the North bound and the South bound lanes of Route 63. 

 

Note:  This places the same dimension on all cross sections. 

Note:  The blue line on the alignment represents the location of the cross-section. 

 

36. Close View 8. 

37. Compress and Save Settings on the design file.  The corridor is stored as MicroStation 

data; no .ird file is created. 

Important!  If you delete the graphics, you delete the corridor and both the 2D and the 

3D display. 

Note:  The User might notice there is no superelevation applied to the corridor, this is 

covered in the next chapter.  

38. Select File > Update Server Copy.  


